MINUTES
Departmental Meeting — Faculty Only
Monday, December 12, 2011, 2:30 p.m.
129 AGLS

2:30-3:30 Faculty Meeting Elliot
e  Summer Teaching
e Reallocation
e APR

Debbie will attach handouts on Maestro OSRS and AgriLife Contracts contact
lists (Attachment A, B, C and D).

Dr. Elliot mentioned that Dr. Boyd was the first one to go through the new
Maestro system. Changes will be of value to us because documentation will
be split as far as Pl and Co-Pl’s.

Dr. Roger Hanagriff has been hired as a Continuing Education Assistant
Professor and will start January 1. He will be housed in 246 AGLS. His hiring
was vetted through the VC’s office, through legal counsel, and also through
human resources. This is a soft budgeted position. The IMS Operations
Committee was heavily involved in this search. Dr. John Rayfield was the
Chair. The Committee worked on seeking approval for the position for over
three months before it was posted. Dr. Hanagriff is a highly sought after for
his professional development expertise. He will devote time to STEM grant
writing, implementing professional development workshops as part of the
service component of IMS, and other IMS/AGSC operations.

Starting today a special mailing form will be required for all like pieces of mail
that number greater than 10. A project account number will be required.
(Attachment E and F). This form will be posted on our intranet site. An email
message from Dr. Elliot will follow.

Conversation moved to summer teaching (Attachment G). Dr. Elliot stated
that the committee had spent a lot of time on the ALEC Summer Teaching
Incentive Pay Policy. No simple solutions are available.

Givens are that we want to provide what is best for students as far as classes
being offered. Thatis as long as it is fundable. At this time, basically all of our
classes are covered by graduate students and faculty and staff who have
summer teaching appointments.

Discussion followed.

Dr. Elliot told the group that the policy was still marked as a draft and that he
was open to positive suggestions.

Dr. Elliot said that he would meet with the Associate Heads on Thursday. He
plans to discuss two items that emerged from the discussion, the sliding scale
(S’s and seats) and modifying bullets 1 and 2.



The next topic was reallocation. Dr. Elliot will present a full report at the
January meeting. As it stands now, we were given the largest amount,
$75,000. It is not to the college yet. Most will stay upstairs and be used
toward student scholarship, etc.

APRs. The key date is February 10, 2012. AIMS system is open now. Data has
been input by Tanya, Clarice, and Elke. Adjustments can be made until
February 24™. You will need to sign up for your actual APR with Debbie
beginning next week.

Dr. Strong said that if you have an AIAEE paper submitted you should know if
it was accepted or not within the week. He asked that you not listen to
rumors. That information has not been released yet. He also asked that if
anyone was planning on attending SAAAE — that the Department will cover
two vans — and to let him know.

Dr. Williams mentioned that award nominations were open for SAAA and
Association of Former Students (AFS). The AFS awards require five years of
teaching. Contact Dr. Williams if you are interested.

Dr. Rutherford asked faculty to let the advisors know if you needed help with
filling classes.

Dr. Elliot wound the meeting up with a discussion of “senior leadership.”
Senior leadership can be faculty of any length of tenure, those who are
concerned with things like stopping the rumor mill and moving the
Department forward.

Travel Request Form Deadlines
Domestic (30 days prior to trip): e.g., travel February 1, 2012 due by January 1, 2012
International (60 days prior to trip): e.g., travel March 1, 2012 due by January 1, 2012

Upcoming Events
Holiday Lunch and Movie, IMS, December 15, 2011 at 11:00
WRAAAE, Bellingham, WA, April 17-20, 2012, Paper deadline December 19
NCAC-24 meeting January 4-6, 2012 host: Texas A&M University
(January 5 — dinner with ALEC faculty at Elliots @ 5:30)
SRAAAE Birmingham, AL, February 4-7, 2012, Paper deadline was October 28th
AAAE, May 15-18, 2012, Asheville, NC
AIAEE Bangkok, Thailand Conference May 21-27, 2012
NACTA, University of Wisconsin, River Falls, WI, June 26-29, 2012
ALE, Key West, FL, July 8-11, 2012

Future Departmental Meetings
January 9

February 13
March 12
April 9
May 14
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Administrative Services

Texas A&M AgriLife Contract Office: Contacts

about: The Texas A&M AgriLife Contract Office promotes both transparent and efficient
customer-oriented support services ensuring seamless processing of non-sponsored gifts,
contracts, and other agreements. We are committed to the delivery of high quality programs,
services, and initiatives that strive to support our agency's mission. Learn more about us...

Contacts ¥

Lewis, Loree; Coordinator of Management Information, Contract Office Oversight
~ lk-lewis@tamu.edu | Phone: 979-845-4759¢

Bouse, Sonya; Financial Specialist | | Cost Share, Time and Effort Reporting
~Isonyabouse@tamu.edu | Phone: 979-458-2773g

Engledow, Carolyn; Financial Accountant | | Gift Processing & Reporting, THECB & NSF
Reports, Texas AgriLife Research 1-A, and Contract Review
I c-engledow@tamu.edu | Phone: 979-458-1858(g)

Klimek, Marilyn; Administrative Assistant | AG-106 Independent Contractor Forms,
Non-Disclosure Agreements, and Hotel/Facility Agreements
I mklimek@ag.tamu.edu | Phone: 979-862-3269§)

Light, Doris; Administrative Assistant | AG-106 Independent Contractor Forms, Non-
Disclosure Agreements, and Hotel/Facility Agreements
~ldmlight@ag.tamu.edu | Phone: 979-862-32729)

Sandner, Tribbie; Senior Proposal Coordinator | MAESTRO Support and Development,
and Contract Review
~|tdsandner@ag.tamu.edu | Phone: 979-458-4383%)

http://agrilifeas.tamu.edu/co/contacts/index.php 12/6/2011
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IEXAS A&M AgriLIFE

Texas A&M AgriLife Administrative Services
Contract Office

Suite 606 Wells Fargo Building | 2147 TAMU
Phone: 979-458-1858¢g) | Fax: 979-862-3285

Texas A&M AgriLife Administrative Services

Physical Address: 3000 Briarcrest Drive; Bryan, TX 77802 | Mailing Address: 2147 TAMU; College Stat
Phone: (979) 845-7879¢f | Fax: (979) 845-0365¢2

Web Site Maintenance: AgriLife Administrative Services
© 2011 All rights reserved

Compact with Texans | Privacy and Security | Accessibility Policy | State Link Policy | Statewide Search |
Equal Opportunity for Educational Programs Statement | Veterans Benefits | Military Families

Risk, Fraud & Misconduct Hotline | Texas Homeland Security | Open Records/Public Information

http://agrilifeas.tamu.edu/co/contacts/index.php 12/6/2011
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Administrative Services

OSRS: Contacts

up date - AgriLife Contracts & Grants functions involving sponsored research projects
have moved to the Office of Sponsored Research Services (OSRS).

quick resources:

Executive Management | Texas AgriLife Research | Texas AgriLife Extension Service
Business Support Services | Other Staff | Organizational Chart

Executive Management ¥

Mark S. Smock: CPA, Executive Director
p. 979-845-8626g | ~ I'msmock@tamus.edu

Melissa Smith: Assistant to the Executive Director
p. 979-845-8626¢g | ~ I masmith@tamus.edu

Leo J. Paterra: CPA, Associate Executive Director
p. 979-845-8670 | == Ipaterra@tamus.edu

Texas AgriLife Research ¥

Diane Gilliland: Director, Contracts and Grants
p. 979-845-4761g | | d-gilliland@tamus.edu

Proposal Administrators

http://agrilifeas.tamu.edu/cg/contacts/index.php 12/6/2011
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Patt Junek | p. 979-845-8668g | = pjunek@tamus.edu

Barry Good | p. 979-862-1382¢ | S jbgood@tamus.edu

Shelly Berry | p. 979-845-8758) | E sberry@tamus.edu

Loren Schroeder | p. 979-845-8654g | ~IInschroeder@tamus.edu

Stephanie Towns | p. 979-845-9309; | ~ Istowns@tamus.edu

Contract Negotiators
Doug Becker | p. 979-845-2672 | | debecker@tamus.edu

Bill Hawke | p. 979-458-4682:g | ~ lwhawke@tamus.edu

Lesli Kerth | p. 979-845-4782e | | Ikerth@tamus.edu

Project Administrators
Atin Agrawal | p. 979-845-7864 | =2 atinagrawal@tamu.edu
Brant Bullard | p. 979-458-0755) | ~ Iprantbullard@tamus.edu

Stacie Grange | p. 979-845-9616¢@ | E sgrange@tamus.edu

Sherry Havard | p. 979-845-8640¢ |  Ishavard@tamus.edu

Texas AgriLife Extension Service ¥

http://agrilifeas.tamu.edu/cg/contacts/index.php 12/6/2011



Contracts & Grants Contacts: Texas A&M AgriLife Administrative Services Page 3 0of 5

Jane Zuber: Director, Contracts and Grants
p. 979-845-8615:2 | == jzuber@tamus.edu

Proposal Administrator

Mia ZwolinskKi | p. 979-845-0434g | I mzowlinski@tamus.edu

Contract Negotiator

Lester Crenwelge | p. 979-845-8658 | 2 Icrenwelge@tamus.edu

Sub-Contracts

Bill Hawke | p. 979-458-4682g | ~ lwhawke@tamus.edu

Project Administrator

Sherry Wells | p. 979-845-2901g) | = sherrywells@tamus.edu

Business Support Services ¥

Travel, Project Payroll, Payables, Deposits, and Reporting
Verna Smith: Director
p. 979-845-3806eg | ~ lvsmith@tamus.edu

http://agrilifeas.tamu.edu/cg/contacts/index.php 12/6/2011
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Payables

Jason Engledow | p. 979-847-8840 | = jengledow@tamus.edu

Airlene Hayes-Muthee | p. 979-845-4788¢) | S ahhayes@ag.tamu.edu

Travel

Akanksha Goyal | p. 979-847-8839:g) | o agoyal@tamus.edu

Purchasing, Receivables (Invoicing and Collections), and Fixed Assets
Diane Hassel: Director
p. 979-845-86093 | ~ Idhassel@tamus.edu

Purchasing

Continue to contact Texas A&M AgriLife Purchasing.

Receivables

Connie Currin | p. 979-845-4780 | ~ Iccurrin@tamus.edu
Charles Neveu | p. 979-847-7988 | S cg-neveu@tamu.edu
Carol Towns | p. 979-845-4683@ | ~ Icltowns@tamus.edu

Bertha Perez | p. 979-845-7760cg | o bgarcia@ag.tamu.edu

http://agrilifeas.tamu.edu/cg/contacts/index.php 12/6/2011
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Other Staff ¥

Alice Conchola | p. 979-845-0519¢ | ~ laconchola@tamus.edu
Nina Estrada | p. 979-845-4781@ | ~ Inestrada@tamus.edu
Elizabeth Grizzaffi | p. 979-458-4362¢@ | | egrizzaffi@tamus.edu

Lisa Payton | p. 979-458-3527¢g | = lapayton@tamus.edu

IEXAS A&M AgriLIFE

TAMUS Office of Sponsored Research Services
Phone: 979-845-8600¢ | 3578 TAMU

Texas A&M AgriLife Administrative Services

Physical Address: 3000 Briarcrest Drive; Bryan, TX 77802 | Mailing Address: 2147 TAMU; College Stat
Phone: (979) 845-7879¢@ | Fax: (979) 845-03654

Web Site Maintenance: AgriLife Administrative Services
© 2011 All rights reserved

Compact with Texans | Privacy and Security | Accessibility Policy | State Link Policy | Statewide Search |
Equal Opportunity for Educational Programs Statement | Veterans Benefits | Military Families
Risk, Fraud & Misconduct Hotline | Texas Homeland Security | Open Records/Public Information

http://agrilifeas.tamu.edu/cg/contacts/index.php 12/6/2011
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Pre-Award: Will allow for the creation, routing,
verification, validation, and submission of
prOpOSBJS e|eC'[I‘OnIC8.||y (electronic submission in development)

IDC walvers are submitted and approved via
Maestro.

NOTES:

This system is used for ALL system members
(College Station based) proposals.

AG-105 is no longer done hard copy.

System routes all documents to all Pls/Specialist
simultaneously.

Maestro Training Session
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Maestro Training Session

WHETENECONAGCT?,

Fo Help:

tdsandner@ag.tamu.edu



mailto:tdsandner@ag.tamu.edu

WHOIENCONTaCT?

Patt Junek
pjunek@tamus.edu

979-845-8668

Lauren Schroeder

Ischroeder@tamus.edu

979-845-8654

Barry Good
jbgood@tamus.edu
979-862-1382

Stephanie Towns

stowns@tamus.edu

979-845-9309

Mia Zwolinski

mzwolinski@tamus.edu

979-845-0434

Shelly Berry- Hebb
sberry@tamus.edu

979-845-8758
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Maestro \Website:
https://epilkmaestro.tamus.edu

Account Request Form:
All Accounts are now set up Electronically

Pls automatically get an account once they
are added to an account in Famis

Supervisors have log in access to approve an
account

Maestro Training Session
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Quick Link to
approving docs

Worklist
We\comemmge | FAQ | Contact | Search | Logout
=prhaestro et

General Tab-

| December 03, 2011 08:14 AM CST
| Executive Administrator Researcher

MyDashboard | Search | MySefigs | BoData | Worklist | ConlactUs | FAQ | AboutEPK-Maesto

General = WorkList = Worklist Feedback
L Worklist
~| Search Saved Search 'Wﬂr.k\étééan:hm
Document Type 1 Change Person B

Search M

Action v Vigw = Format »

swnter  [owson Jarout|Submssion urker

Click on Proposal #
to see the proposal
information

Maestro Training Session
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Executive Administrator Researcher

WyDashboard | Search | MySetings | BoData | Worklist | ContactUs | FAQ | AboutEPK-Maesto

General o WorkList = G

enaestro

Worklist
‘General Info
Personnel

IDC Waiver Request
Reporting Code
Notes

Decision

Click on categories to see

Proposal General Info

~| General Info

Proposal #

Title

Sponsor

Proposal Type
Function

Activity Type

Pl

Co-PI

Lead Organization
Center

Administrative Organization
Project Begin Date
Project End Date

Total Amount

10C Base Amount

1DC Base Type

IDC Rate

Cost Sharing Required

information contained in
the in the section

1210042

Research on the Developement of Maestro
Texas A&M Foundation

New Application

AL-RSRCH Taes Administration

Agriife Research

10,000.00

Wodified Total Di
10.00

No

Maestro Training Session

K<

Last updated on 01-D 1 by Tribbie Sandner

Cost Sharing Exists ||
Budget Split Exists [ ]
IDC Viaiver Request Exists
Compliance Issue Exists
Conflict Of Interest Exists [ |

Subrecipient Exists [ |

For Proposal Information, Please Contact
Tribbie Sandner

tdsandner@ag.tamu.edu

TR

Last updated on 01-Dec-2011 by Tribbie Sandner
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Executive Administrator Researcher

MyDashboard | Search | MySetings | BioData | WorkList | ContactUs | FAQ | AboutEPK-Macsto

ral = WorkList

Worklist
General Info

Proposal Routing Decision

bersonnel | Current Proposal
Compiian:

Routing Package
IDC Waiver Request
Reporting Code: | Routing Decision

Proposal 1210042 Pl Tribbie Sandner

Notes ATTN. INVESTIGATORS:
By clicking Approve button, you certify, to the best of your knowledge and belief, that ...
a) You are net delinguent on any Federal debt, such as student loans, etc. (this does not include income taxes): (applies to felowships, scholarships, IPAs,

b) You are net currently debarred, suspended, proposed for debarment, declared ineligible, or voluntarily excluded from current ransactions by a Federal department or agenc,

ot responsibiity for the tific conduct of the project and to provide the required progress reports if an award is made as a resutt of this application

) You understand that any false, ficttious, or fraudulent statements or y subject you to crimi | or administrative penalties.
agree to comply with the TAMU Conflict of Interest Rule (per 60 FR 35620, 7/11/95; NIH 60 FR 0, TH11/95).
ou agree to comply with the TAM| on Ethics in Research and Scholarship, TAMUS #15.88.03.
agree to comply with the TAMUS regulations on Management of Intellectual Property, TAMUS #17.02.01
ertify that the information submitted within the application is true, complete and ate to the best of your knowledge,
i} | agree to disclose any nepotism issues and agree to follow TAMUS policy 33.03 Nepotism

i You have ed applicable subawardee documents, if any, including the subawardee’s statement of work and budget and both appear reasonable and necessary for the s

ATTN. DEPT. HEADS, DIRECTORS, DEANS:

By clicking Approve bution, you certify that you have received this proposal and all accompanying documents, you are aware of all requirements of this project and ar

N_qte_s or Reason For Rejectign

Add Comments or Reason
if rejecting

Maestro Training Session

enaestro

December 05, 2011 08:24 AM C5T

Approve

Developement of Maestro

and A-129.)
(per Executive Order 1

essful completion of the work stated in the application

mitted to providing them except as noted

Approve

Click on your choice




e
General Tab- ey naestro

My Settings

F Sl hd

I | My Seftings I Bio Data | WorkList ] Contact Us J FAQ ] Abaut EPIK-Mazstio

Profil Picture | Executive Portal Seffings

Bio Data Delegate Executive Organization _TaNUS Agicuture Q Executive View Type i.i:"ﬂ Aty with Aszogites
Bio Data Section Acoess: -
\;i) r next login

! Personzl Info To change this information go to hittps

First Name Tribbiz Street Address
Last Name Sandnzr Mail Stop
Middle Initial 0 City
State T
ZipCode TT243247
Work Phone

| Routing Setting
hoton + Vi Fomaty | [ g | @

Set up alternate approver
for documents

| Proposal Setting ‘

hcton+ Viewe Fomate @ é

Set up alternate support
person for proposals

| User Aecess

View ~ Fomat ~ a

Maestro Training Session



"—-—'—‘--.

ey naestro

Sl RIGRN/OUIFOWHINPIOPOSE

Researcher Tab-
Proposals
& LLANANS LA ou T’ TiE Tyou RER appro DECEMOeT 03, 2UTT 10 15 Al o

My Dashboard ] Accounts ] Projects ] Proposal

Current Proposal List Current Proposal List ( Tribbie Sandner)

~| Proposal Search | Saved Search | Search Proposal El

Proposal Number [ Routing Status E

C re ate a n eW S i ) Pl | Sandner, Tribbie
re C O rd Tt | Proposal Administrator (PA) |

Proposal Type | cFDAE |
Lead Organization [ ( Sponsor
Administrative Organization [ RFP#

Proposal Status [ No PA

Proposal
Humber

In Routing

Number automatically
assigned

Maestro Training Session
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" LIIUCHLIO

General Executive Administrator X

Current Proposal List Pl Tribbie Sandner Status Date 29-Nov-2011
General Info * Lead Organization | A|_RSACH Taes Administration (< Routing Status Mot Started
Personnel Center | ir Q Routing Status Date Z5-Nov-2Z011

Compliance . A !
* Administrative Organization | Agrilife Research El moun 150,000.00

Document
IDC Waiver Request * Title ;'Resea rching my trip to temple
IP Waiver Request
Budget Spit IDC Rate | 46.50
Cost Sharing i i —
Cost Sharing Required |

Subrecipient tho E
Action Project Begin Date |

IDC Base Amount | 100,000.00

IDC Base Type | 1odified Total Direct Cost =]

Hickname |

Motification Project End Date |
Access Control Cost Sharing Exists |:|

Tasks Budget Split Exists [ |
Notes Activity Type IDC Waiver Request Exists [ |
Function | Compliance Issue Exists
Conflict Of Interest Exists [

Subrecipient Exists [

* Proposal Type | pre_proposal

Competitive [
Peer Review |
RestrictediClassified | g lz‘

Legacy Number [

~| Sponsor And Program Information

* 8pONSOr | TAMU - Center for Environmental and Rural He: RFP# |
Prime Sponsor | Q Opportunity Title |

Sponsor Address

Opportunity URL |
|
Deadline Type |

Technical Contact |

Phone |
* Deadline Date | 15.pec-2011

Email |
Submission Requirements |

Fax | |

Maestro Training Session
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fyDashboard | Accounts | Projects | Proposal

Current Proposal List Proposal Persennel
General Info

Personnel

Compliance /| Current Proposal

Document Proposal Pl Tribbie Sandner Title Researching my trip to temple
IDC Waiver Regquest

IP Waiver Request

Budget Spiit

Cost Sharing ion ~ View ~

~| Personnel

Subrecipient

Columns Hidden

| Proposal Contact (If Not P1)

Action - View ~ | Hi

|Mame E-Mail

No data to display.
Columns Hidden 4

Add someone as the
primary point of contact

Maestro Training Session
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F T T A= AT

Administrator

Executive

MWy Dashboard | Accounts | Projects | Proposal

¥

Researcher = Proposa

Current Proposal List IDC Waiver Request
General Info

Personnel

Complianc | Current Proposal
Title Researching my trip to temple

Document Proposal Pl Tribbie Sandner

IDC Waiver Request
P Waiver Reguest
Budget Spiit

Cost Sharing ction = View ~ @ ; # @

DCRate | Rate
Sponsor A\Inv;ri:(%} equested Budget IDC Amount Waived |Status Status Date Creator

IDC Waiver Request

No data to display.
Columns Hidden 6

| Routing Log

Action ~ View + | L

[ By i . |
Routing End Time Submitted By Revoked By

Pl creates IDC waiver and starts
route.

Predefined routing paths

Maestro Training Session
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General Tab-

Bio Data

~1NAeSIIO

Administrator

My Dashboard | Search | MySettings | BioData | Worklist | ContactUs | FAQ | About EPIK-Maestro

General = Bio Data » S=lect

Select Person Select Person (Sandner, Tribbie)
Institution

Templates Currently Selected Person Is (Sandner, Tribbie)

Resume/Bio Sketch ——
Frttame —|Lastane —

Professional Registration

Languages Fluent In

Personal Statement

References

nal ldentity

Education

Education

Supplementary Education

Certification

Researcn Select person who you

Area Of Interest

TAMUS Projects are e nte rl n g for If

Non TAMUS Projects

bio-data delegate

Publication

Upload Publication

Presentation
Professional Membership
Collaborator

Intellectual Property
Patent
Copyright
Disclosure

Maestro Training Session
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Create a new
record

“yMaestro

Executive Administrator Researcher

MyDsshbosrd | Search | MySetings | BioData | | ContsctUs | FAQ | AboutEPK-Maesto

General = Bio Data = Education = &

Select Person Education (Sandner, Tribbis
Insttution
Temphites | Education
Resume/Bio Sketc! = ; :
Sy Acton ~ View v Format ~ | i fi hsttufon | @ | B
Personal Info > Gl T Advisors
Degree Type Degree Year | Instiution Primary Discipling Secondary Discipling
Professional Registration Exists?

Languages Flusnt In Ell E!r: m EI “

Personal Statement Columne Hidden 4

External ldentity

- Education | Degree Advisor For () -

Education Aclion v View = Format =
Supplementary Education —
Certification

Mo data to display.
Experience 3
- Columns Hidden
Special Recognition
4+ Research
+# Publication
4 Service and Activity
+ Intellectual Property

Maestro Training Session
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Ext

ecutive Adi

trator Researcher
MyDashbosrd | Search | MySetiings | BioData | Workist | Contactls | FAQ

al = Bio Data = Re

Select Person
Instiution

Area Of Interest (Sandner, Tribbie)

Templates

Resume/Bio Ske

General
Personal Info
Professional Registration
Languages Fluent In
Personal Statement
References
External identity

= Education

Education
Supplementary Education
Certification

Experien

TAWUS Projects
Non TAMUS Projects
Publication

Publication

Presentation
Professional llembership
Collaborator

Intellectual Property
Patent
Copyright
Disclosure

Maestro Training Session

| About EPK-Wzestro

Iz Primary
Interest ?

Keyword Descripi

Mo data to display.

3D Modeling

30 Nanostructures
ABA

AlZ

ADS

AIDS Counsgling

AIDS Wental Health

AIDS Wouse Model
AIDS Perinatal/Pediatric
AIDS Sexually Transmitted
AIDS Substance Abuse

Selecting Keywords will
allow you to receive
funding opportunities

enaestro

Dece
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Executive Administrator Researcher

MyDashboard | Search | MySetings | BioData | Workist | ConfactUs | FAQ | AboutEPK-Maesto

General = Bio Data =

Templates (Sandner, Tribbie)
Institution
Templates | Search
sume/Bio Sketch
eneral
Personal nfo Hame Contains
Professional Registration Type quuals
Languages Fluent In Department :Equals
Personal Statement :
References Visible to | Equals
External Identity
= Education
Education Action  View = Format = e s L | etach | ¢ Wrap
Supplementary Education
Certification
Experience
Special Recognition -
# Research GENERAL ENETiC N ith Parameters
NH Bingraphical S| SENETic N i ith Parameters
NSF Biographic Generic N Preview with Parameters
Columns Hidden 4

% Publication

% Service and Activity

# Intellectual Property

Several CV templates
already designed or you can
design your own

Maestro Training Session
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General Tab- ey naestro

My Settings

~IIIACSII0

Executive Adn\gztrator Rezearcher

Wy Dashboard ] Search J My Setfings ] Bio Data WorkList Contact Us FAQ About EPIK-Maestro

General « My Settings = Bio Data Delegate

Personal Setting Bio Data Delega'
Profile Picture

Bio Data Delegate
Bio Data Section Access

~| List Of Delegates

Action ~ View - Format « @ Dﬁ |

Mo data to display.
Columns Hidden

Set up alternate support
person for CV

Maestro Training Session
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A newly developed system to support
researchers & specialist and research
administration across the
Texas A&M University System

Maestro Training Session
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Provide researchers & specialist with timely and
accurate information needed to manage their
research & extension activities and to establish
collaborations

Publish up to date research key performance
Indicators for all TAMUS institutions and Board
of Regents.

Streamline research administration processes to
minimize Inefficiencies and improve turnaround
time

Maestro Training Session
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q9
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(1ISE
RS fen o)
Creates a Research Data Warehouse By
combining FAMIS, B/P/P, Canopy, Epik

alS

L
i
ps

S

Gives researchers & specialist easy access to all
their projects & accounts and associated
documents

Administration and executives will be able to
monitor and analyze proposal, award and
research expenditure activity

Maestro Training Session Currently Available
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Pre-Award: Will allow for the creation, routing,
verification, validation, and submission of
proposals electronically.

Currently in Use

Post-Award: Will expedite award acceptance,

minimize budget anc

cost sharing data entry,

Improve project com
project close-out pro

Maestro Training Session

nliance and simplify the
CESS.

In Development
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Will consists of systems such as research
sponsor billing, receivable reconciliation,
Indirect cost calculation and distribution,

payroll certification and internal/external
reporting

Expected start of development- 2012

Maestro Training Session
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SEWNGFSLaReEd

Maestro \Website:
https://epilkmaestro.tamus.edu

Account Request Form:
All Accounts are now set up Electronically

Pls automatically get an account once they
are added to an account in Famis

Supervisor have log In access to approve an
account

Maestro Training Session
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=pmaestro —

Advanced Search

HOME ] FOR RESEARCHERS

Manage This Account
Change Password

Login

About Project
Research Areas
Research News

AEM System Awards

NEWS [ OPPORTUNITY (2

Poston to attend White House reception honoring HHS advisory Teaching Development Fellowships G |VeS fu n d | n g

board service Humanities {see "Cultural Affairs™ in CFDA)

Mark Ellison named director for corporate relations for TEES Meetings of the Institutional Corrections Research Network and Two O p p O rtu n |t| eS

Subject Matter Experts Meetings on Correctional Research

Energy Engineering Institute signs wind energy agreement Other {see text field entitled "Explanaticn of Other Category of
Funding Activity” for clarification)

Shenandoah National Park: assessing climate change factors that
impact natural resources in the park

U S S O Environment
S e yO u r Pre-application for a Biomedical Technology Research Center (X02)
Log-In info

Health

Biomedical Technolegy Research Center (P41}
Health

Regulation of Surface Coal Mining and Surface Effects of
Underground Coal Mining
Natural Rescurces

e Fiie Texas A&M UNIVERSITY Imjommation Systems.

\f?ﬁ@?_'. Texas Engineering Experiment Station
d 7 I The Texas A University n
-___"22}/ S E M Privacy Statement

State of Texas Texas Homeland Security Statewide Sesrch TAMUS policies

Maestro Training Session
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Welcome Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
&N aestro June 21, 2011 09:14 AW COT

Administrator

Home J Accounts Projects

Researcher = Accounts =

ent Account List Feedback

Current Account List Current Account List (Sandner, Tribbie)
Account Info Shaded projects END

Account Balance ~/| Search Options Saved Search |Accoun

ccount Balance Detg,

. Pl Hame ':'-;anﬁner, Tribbie : Sponsor Abbreviation |
Account Transaction

. Account Number Sponsor |
Payroll Transactions,

Praject Title | Primary PI |V
Payroll Commitmen | rimary Pl |

Member | ]
Payroll Allocations, i 2 E| T
Department SL summary | N

Change between
ACCOU”tS & m_v View » Fur_matv Detach @}Wra;{
Projects |

If you are having an issue

n AL nd Date | Project Title .
= — R e with a screen, use Feedback
MO 0ald 10 Cispiay.

| 1 e | [ 000000 to help us improve

Columns Hidden 2

Maestro Training Session
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Welcome, Tribbie Sandner | My A ct | S
=pnaesty
eS1I0 g

Search My Settings ] Worklist ] Contact Us ] FAQ

Gansral T

Personal Research Accounts
When you sign-on, urhumPpa;P\'ﬂlldlspl th"llst[‘f ur a

¥ SEE genel 2 0 ount administrator ct information. Thiz person
will be able to help if there are gquestions related to the accounts. Alternat ntact names are:

_m__

[ zmd, Diane E :I—'IIIIl!'|:|E1|.|»-!.|
:»glLIro E er, Trivoke 27455 idsandne| S edu
TAMHEC E E -

TAMRF E
TAMRF NanCy

General User Support

aestro Administration

Epik-Maestro Project Director G IVeS U p d ate d C O n taCt

Leonarda Horvat

for each agency

Mailing Address Physical Address

3579 TAMU 1470 Wiliam D Fitch Pkwy
College Station, Texas 77843-3579 College Station, Texas 77845-4545
Fax: 879-458-7727

FaE TeExas A&M UNIVERSITY Information Systems
Texas Engin g Experiment Station
The Texas A&M University System
Privacy Statement

Maestro Training Session



General Tab

Search ]

Area Of Interest Search
Awards Search

Inventory Search
Keywords Ssarch
Opportunity Search
Sponsor Search
Organization Search
Expense Category Search
Fesdbsck Search
Institution Search

Approve
Documents

Search Special Recognition

~| Search

Match @ A1) Any

Specizl Recognition Name | Contains
Special Recognition Type | Equsl to
Institution lssuing Recognition | Equalto

Organization "Equal to

Action » View » Formst E B Detach

Keyword Description -qusal to

Criteria Name | Equsl to

Deadline Day | Equalto

Deadline Month | Egual to

enaestro

Welcome Tribbie Sandner

Saved Search |Specil Recogniten Search [¥]

Special Recognition
Type

Institution |zsuing Recognition

Preparation
Time {in

days)

Organizations To Be
Notified

Lots of search g=
options.

Maestro Training Session
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=ptnaestro

My Settings |

Eessonal Selig My Settings (Tribbie Sandner) g Save [ Cancel
Bic Data Delegate
Sio Uata Section A Personal Setting

Select Skin | a0 Font Size | piedium Izl Select Home f‘Cunent Acocount List E

Executive Portal Setting

Executive TAMUS Agriculture Executive View | org activity with Assodistes [ ¥ |
‘Drganization Type

Personal Infi To change this i ion go to hitps://sso.tamus.edu/

First Name Tribbie Street Address 2147 TAMU
Last Name Sandner Mail Stop 2147

Middle Initial O City College Staticn
Add your s .

Email tdssndnen@ag.tamu.edu Zip Code 778432147

we bSIte url | Work Phone

Work Department Directors Office

Routing Settin

Add alternate [eSSeadaadl-L IR

Document Type Badkup Path User Maotification
approver e _

User Acces:

View ¥ Format » E Freeze a‘ Detach &l Wrap

Role Name Access Type Access Value

Allow Login

Deliverables Admin MEMBER 11-Texas Forest Service[TFS)

Deliverables Admin MEMBER 20-Texas Veterinary Medical Diagnostic LeboratonyTVMDL)
Executive ORGANIZATION  -TAMUS Agriculture {)

Executive ORGANIZATION  AL-EXT-Agrilife Extension Service (AL-EXT)

Maestro Training Session
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Work List

Worklist
v| Search Saved Search | WorkiistSearch [¥]

Document Type | Change Person

Search Reszat

Action -~ View ~ Format » |

No data to displzy.

Maestro Training Session
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Bio Data

Search | MySeffings | BioData | Workist | ContactUs | FAQ

General * Bio Data * S=lect Person

S SV Select Person (Sandner, Tribbie)
Institution
Templates Currently Selected Person Is (Sandner, Tribbie)
Resume/Biosketches I
+ General
4 Education
Experience
Special Recognition
Area Of Interest
% Publication
% Service and Activities
4 Intellectual Property

Maestro Training Session
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Export to Excel

See all accounts for
Sort Account Type Researchers/Specialist

mO andner | My Settings | FAQ | Con
EP aes June 22, 20

General Executive Adrinistrate
| Aecounts |

her = Accounts

Current Account List Current £  List {Stelly, David)
Account Info
Acoount Balance

| Bear

Saved Search  Account List Search
Account Balance De

lameer il Pl Name, 4 Q Sponsor Abbreviation
Eayrol Tr Account Numbs, Sponsor
Payroll Commitments.

Project Ti| Primary P 21
Fayroll Allocations

Hem) Satus  Active

Sort by Agency ' e

< [3

&ction = Viw - Formate | | [ Detach
_‘ _ _
Ny — e Account balances
: ; ' with all SAs rolled up

arent Projest Spansor
2 0.00 Farent Proje

Fy11 Cotton Improvement -
002011 08 Steny

View can be
customized to

needs Sort by Sponsor

Sort by End Date

Maestro Training Session
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Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
EP] aes o July 05, 2010 03:08 PM CDT

General | Executive | Administrator } F

Accounts | Projects

Researcher » Accounts » Account Infe Feedback

Current Account List
Account Info
Account Balance

Account Number System Member
40592470260 AL-RSRCH E Change Account

405924-70360 Germplasm Introgression for Tx Cotton Improvement - Interspecific and Intraspeci

Account Balance Detall Sponsor: Cotton Incorporated

Account Transactions :
Account Information

Payroll Transactions i
Payroll Commitments Principal Investigator David Stelly Status Active

David Baltensperger Project 0000405924 - Germplasm Introgression for Tx Cotton Improvement -

Funding Period 01-Jan-2010 to 31-Dec-2010 Interspecific and Intraspecific Crosses
Setup Date Current Funds Yes
Administrator Engledow, Carolyn Gift Fee Exempt No
9794581858 BottomLine Budget Yes
ckengledow@ag.tamu.edu Control

Sponsor Cotton Incorporated FAMIS ABR Rule 009
Funding Type Private Budget Sort 693015
F&A Cost Method - 0% NONE NACUBO Function 15 - Research
Effort DRES - Direct- Organized Research

Fue Texas A&M Information Systems

| i Texas Engineering Experiment Station
— The Texas AGM U.ni.«t";it-. System
Once you select a specific e

account, you can access
general and specific information. s N e QRS LIOK

Maestro Training Session
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Allows you to change dates

: Of |nformat|0n . Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
| EPI des To July 05, 2010 03:11 PM COT
[ Genea rcome

| Accounts | Projects

| Researcher = Aceounts = Account Balance
Current Account List ! A } m Member rt End Category

count Info - AL-RSRCH [¥] * [2010[=]" |07-July (=] * [2010[=]" |07-July [=] * [m: | Change Options |
40592470360 Germplasm Introgression for Tx Cotton Improvement - Interspecific and Intraspeci

Sponsor. Cotton Incorporated

count Balance Detail — -

Account Balance - (Real Time Balances)

| Account Balance

0.00
0.00
0.00

3,000.00 :
2,000.00 B : 290.00
0.00 X 0.00 0.00
0.00 i 0.00 0.00
0.00 X 0.00 0.00
0.00 0.00
0.00 0.00
0.00
Direct Only Total : 5 6,430.70 : 13,131.38
Account Total 5 6,430.70 131

y THE TExas A&M UNIVERSITY Information Systems

: Texas Engineering Experiment Station

] S i S I E M The Texas A&M University System
Privacy Statement

Internet | Protected Mode; On

Allows you to drill down to
specific expense categories
and see related charges.

Maestro Training Session
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Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
% c:es 1’0

July 05, 2010 03:14 PM CDT

Administrator

Accounts ] Projects

Researcher #* Accounts #* Account Balance Detsil

Current Account List Account Number 2m Member  Start End

Category
P 10592470360 AL-RSRCH [w] * [2008[¥]" [01-January  [¥] ™ [2010[*]" [07-luy [¥] * [Maestro[w] L.Change Options |
Account Balance Type Category Codes
nditure Other Expe
T s Expenditure E Other Expe E

40592470360 Germplasm Introgression for Tx Cotton Improvement - Interspecific and Intraspeci

Account Transactions Sponsor: Cotton Incorporated
Payroll Transactions ]

_ Account Balance Detail
Payroll Commitments

View» Formate

Employee Training - Reg i
ME&R - Motar Ve
Contracted Servi
Other Contracted Servi
Rental of Containers
Rental of Space - Other

i, THE Texas AAM UNIVERSITY Information Systems
: Texas Engineering Experiment Station
] ; The Texas A&M University System
SYS I E M Allows you to drill down to pl

Privacy Statement
sub codes

Maestro Training Session
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Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
Emro July 05, 2010 03:17 PM CDT

General | Executive Y Administrator | R

Accounts | Projects

Researcher #* Accounts * Account Transactions

Current Account List Account Number System Member  Start End Category

AccountInfo 10592470360 AL-RSRCH [w] " [2000[¥]" (0t-anuary [w] " [2010[=]" [07-July [=] * [Massto[¥] LChange Options |
Account Balance Type Category Codes Subcode

Expenditure |w Other Expenses M&R - Motor Vehicles
Account Balance Detail : D P E EI

40592470360 Germplasm Introgression for Tx Cotton Improvement - Interspecific and Intraspeci

Account Transactions Spansor: Cotton Incorporated

Payroll Transactions
Account Transaction - (Real Time Balances)

View~ Format«

Transaction Document Document .
Am S
Transaction Date 'Description ouni|P0 Reference Number Description ubcode Title

06/18/2010 TEXAS A&M UNIVE.. 153.29 L039556 6061693 FUEL W403731PA... M&R - Motor Vehicles

Payroll Commitments

Columns Hidden 1

Allows you to see each ormatonSystems t
- EXas engineenng xperiment Station
charge for the categories The Texas ABH Uniersity Sysem

Privacy Statement

and sub codes.

Maestro Training Session
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Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
July 05,2010 03:17 PM CDT

Accounts | Projects

Researcher * Accounts * Account Transactions

Current Account List 0 Category

: N = —
Account Info 405] File Download ' X E s E rrm———
count Balance TYE |
count Balance Detail Do you want to open or save this file? i 5]

4059,
Account Transactions Spons

e Name: FAMIS_PurchReport_L039556.pdf
Payroll Transactions IE? B ol P
o ; Acco Type: Adobe Acrobat Document
Payroll Commitments
Vi From: epikmaestro.tamus.edu

n
Save C ancel

403731 PA... ME&R - Motor Vehicles

While files from the Internet can be useful. some files can potentially harm
your computer Ifyou do nottrustthe source, do not opjen or save this file.
What's the

Columns Hidden 1

e Texas A&M UNIVERSITY Information Systems

. : Texas Engineering Experiment Station
/ S Y S T E M . . The Texas A&M University System
A”OWS you view SpeC|f|C Privacy Statement
documentation for a charge

Maestro Training Session
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Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
epMMAaesiro

Juby 05, 2010 03:2% PM CDT
avstem

Accounts ] Projects

Researcher * Accounts * Account Transactions

Current Account Lis 3 ] ] End Category
Account Info i [=] * [2010[=]" [07-duly [#] * [Maestro|+] _Change Options

Account Balance Type Subcode

Encumbrance |z|
48253100001 Genetic And Functional Genomic Anal

Account Balance Detail
Account Transactions
Payroll Transactions

Payroll Commitments

Salary Encumbrance

T Allows you to see
payroll charges

Information Systems

Texas Engineering Experiment Station
The Texas A&M University System
Privacy Statement

Maestro Training Session
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Accounts | Projects

Researcher * Accounts * Payroll Commitments

Current Account L
ount Number System Member
7570350 AL-RSRCH [7] *
12447570360 Fy10 Cotton Improvement Fy08 -Stelly
Account Balance Detail Sponsor: Parent Project Spansor

Account Info

Account Balance

Account Tr: 5

Account Payroll Commitments - (Real Time Balances)
Payroll Commitments

Dwame Raska
Shivapriva Manc.

ndria Prom
Wacant

di, THE Texas A&M UNIVERSITY

Maestro Training Session

Change Option.

Allows you to see
payroll commitments

Welcome, Tribbie Sandner | My Settings | FAQ | Contact | Search | Logout
July 16, 2010 04:08 PM CDT

Information Systems

Texas Engineering Experiment Station
The Texas A&M University System
Privacy Statement

€ Internet | Protected Mode: On



December 12, 2011

| encourage and am in complete support of all research being conducted by
ALEC faculty and students. With that being said, we are moving forward
strategically to cover research administrative costs (printing, envelopes,
postage, etc). With recent budget cuts, restrictions, and reductions, we
must utilize all funding sources to support this important and essential
ALEC activity. A form is being developed to assist you in keeping up with
these costs.

Therefore, beginning December 12" the attached Special Mailing Form,
with appropriate project account number, will be required for all like pieces
of mail that number greater than 10. Funding sources include the Office of
Graduate Studies (OGS), grants, individual faculty accounts, etc. Share the
form with your graduate students and encourage them to submit graduate
research request forms in a timely fashion to the Office of Graduate
Studies.

Jack Elliot



DIVISION OF FINANCE

JT!& ‘ TEXAS A&M

UNIVERSITY

SPECIAL MAILING FORM
(Mail to be Metered)

From:
(Sender’s Name)

(Department) Agricultural Leadership, Education, and Communications

Billing Account Number:

Billing Account Name:

Dept. Phone Number: 979.862.3003

Return Form To: Debbie King
(Name)
(Department) Agricultural Leadership, Education, and Communications
(Mail Stop) 2116

Project Account Number:

Please Send Attached mailing:
() 1st Class
() Book Rate-Media Mail
() Air Mail-International First Class
() International Priority
() Parcel Post
() Library Rate
() Nonprofit (Bulk Rate)
(' ) Insured ($5000 maximum - Domestic Mail Only)
() Registered Mail (Dollar Value)
() Certified

Description of Mailing: (brochures, applications, bills, letters, flyers, etc.)

Number of Items Mailed: Date Submitted for Mailing: Charge for Mailing: (For Mail Service Use Only)

Signature:



ALEC Summer Teaching Incentive Pay Policy (12/12/11)

Priority for summer teaching funds will be determined by course demand, core curriculum (no other

course can be or has been substituted for that course), course evaluations, and previous course

enrollment.

e Faculty members on 10 or 11 months of funding, who offer to teach in the summer, will be paid

50% of the amount on the payment schedule below for the first course. Additional courses

offered in the same semester will be paid the full amount on the payment schedule below for

each course completed.

e Faculty members on 12 months funding, who offer to teach in the summer, will be paid the

amount on the payment schedule below for each course completed.

e Faculty members offering to teach in the summer agree to teach the course for no additional

compensation in the event the course “makes” (meets University minimum enrollment), but

fails to reach the minimum enrollment for ALEC funding.

e Study Abroad courses offered in the summer will count as the “first course” for faculty members

on 10 or 11 months of funding; additional courses will be paid the full amount on the payment

schedule below for each course completed. Summer study abroad courses that meet the

minimum enrollment values on the payment schedule below will receive summer funding from

the department.

Funding from the College has been requested to support large classes (60+).

Summer Course Payment Schedule*

ALEC Minimum UG class w/Masters UG class w/Doctorate Grad class w/Doctorate
*Census Enrollment

10-19 *AN/A *AN/A $4,500

20-40 $3,500 $4,500 $5,000

41+ $4,000 $5,000 $6,000

*Enrollment is determined by the official TAMU Census Day enrollment numbers (12th Day of Long

Semesters, 4th Day for Summer).

**0Only courses with a minimum of 20 UG, or 10 G, will be considered for summer funding.

Draft Summer Teaching Policy

12/6/12 update
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